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Start

Mints is a growing collection of tools to provide deeper insight into macOS, to help you understand how its features work,
and to help diagnose its problems. In this release, 14 tools are provided: these provide log extracts covering iCloud, TCC
privacy protection, Time Machine backups, the App Store, and task scheduling, test Spotlight search, look for Universal
binaries, and show information about the Mach timebase, hardware, process environment, sudo, mounted volumes and
keychains. There’s also a new menu in the Window menu to explore different Data... types, the first of which is the Double.

Complex systems in macOS write dialogues to the log while they operate. Following these in a normal log extract can be
difficult, because lines in each conversation are interspersed with other irrelevant entries. Mints’ log browsers are different
because they bring together entries from many different sub-systems and services, helping you to follow those dialogues.
The use of colour to distinguish different sub-systems makes these conversations even more understandable.

[ JoX ) Mints Time Machine log
Period | -20|{ min a relative to  14/07/2020, 16:00:34 N Now
Time Machne @ DAS @ cTs @ Other
Get log Save

E3FD397D

20-07-14 15:44:51.668 DuetAS @:com.apple.backupd-auto:@45ABB: [

{name: DeviceActivityPolicy, policyWeight: 2.000, response: {Decision:
Can Proceed, Score: 0.40}}

{name: MemoryPressurePolicy, policyWeight: 5.000, response: {Decision:
Can Proceed, Score: 0.50, Rationale: [{[memoryPressure]: Required:2.00,
Observed:1.00},1}}

] sumScores:31.810000, denominator:35.510000, FinalDecision: Can Proceed
FinalScore: ©.895804}

20-07-14 15:44:51.668 DuetAS '@:com.apple.backupd-auto:@45ABB'
CurrentScore: 0.895804, ThresholdScore: ©.758907 DecisionToRun:1l

20-07-14 15:44:51.669 CTS-XP S o

DAS told us to run com.apple.backupd—

com.a
Initia
taking
20— Mach TMPowerState: 2

20-07-14 15:44:51.770 DuetAS STARTING activity @:com.apple.backupd-
auto:@45ABB <private>!

=»> Contents =»> Main window
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Main window

eo0e Mints -~ macOS Version 11.3.1 (Build 20E241)

Log Windows iCloud TCcC
Time Machine App Store

DAS Scheduling

Spotlight Log Window

Create Test > Check Search > Delete Test

Information Mac Volume Keychain

Environmen it Mach Absolute Time

The main window currently offers 15 buttons to:
open the =» iCloud Log Window, to explore iCloud messages in the log,
open the =» TCC Log Window, to explore TCC and privacy system messages in the log,
open the =¥ Time Machine Log Window, to explore Time Machine backup messages in the log,
« open the =¥ App Store Log Window, to explore App Store messages in the log,
+ open the =% DAS Scheduling_Log Window, to explore task scheduling messages in the log,
+ open the =» Spotlight Log Window, the explore Spotlight searches in the log,
+ =» create, run and delete a test of Spotlight search,
+ = Get Mac Info,
+  =» Get Volume Info,
+ =» Get Keychain Info,
+ =» Get Environment Info, about process execution environment,
+ open =» Mach Absolute Time, to get information about clock rate and conversion factors,
+ open the =» Universal Binary Checker, to discover which apps and other code runs native on Apple Silicon Macs
(available in Mojave and later only).
When you close this window, Mints will quit.
=» Log_window controls
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Log window controls

@® ® Mints Time Machine log
Period | -20{C min |3 relative to 14/07/2020, 16:00:34 # Now
Time Machne @ DAS @ CTs @ Other
Get log Save

<private bt
6E3 j Z r’,V‘T[: 7‘ - P7 : U

anic/TheTimeMachineMechan

options: 768

20-07-14 15:44:51.668 DuetAS @:com.apple.backupd-auto:045ABB: [

Each log window in Mints offers a simple method to specify the precise period over which log entries are to be
extracted. This is based on a reference time, entered in the relative to box using its standard controls, and a
Period offset from that reference, set using its stepper arrows or by editing the text directly. You can also copy and
paste times in the relative to box: simply select an item in the box and use the normal commands.

The offset entered in the Period box has a popup menu to determine its units. There is also a button Now which
will set the reference time to the immediate present. Use that with a period of —20 sec to get log entries over the
last 20 seconds.

To get a log extract for the 1 minute before a reference time, simply set Period to —1 and the popup menu to min.
To obtain an extract for 10 seconds each side of a time in the past, the total period wanted is 20 seconds. You can
either specify that using the reference time at the start of that period and 20 sec, or the time at the end of the
period and —20 sec.

=» Log window controls (concluded)
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Log window controls (concluded)

The shortest period which can be used here depends on the version of macOS. In Sierra, periods less than about
30 seconds are unreliable, and entries can be missed. In Mojave and Catalina, shorter periods can be used, even
below 10 seconds if you wish.

Times in the relative to box are in the current time zone for the set date. On days when clocks change, they use
the second of the two zones. For example, when the change to summer time occurs on a day, times entered here
for that day use summer time throughout.

The row of controls below the time settings set which sub-systems are shown in the log view in the main part of
the window. Each uses an emoiji to indicate the colour in which those log entries are displayed.

The last controls are two buttons: Get log, which runs the log show command to fetch a fresh log extract, parse
and display it, and Save, which saves what’s currently displayed of the log in Rich Text format, which you can also
do through the Save command in the File menu.

To enlarge the size of the text in any log extract, press 3 +; to reduce the size, press ##—.

Each time you open Mints, it checks whether your log is in order and accessible. If it detects any problems, it will
warn you about them, and suggest fixes when possible.

=» iCloud log
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iCloud log

[ NON ) Mints iCloud log
Period S sec relative to 14/07/2020, 16:02:00  C Now
CloudDocs @ CloudKit @ MMCS @ Other
Get log Save

StateComplete 1

20-07-14 16:01:44.680 [kernel]l com.apple.p2p: AWDL Active Time
1797ms (13%) 12.871s[2491065.044s — 2491077.916s]

20-07-14 16:01:44.688 [kernell 2491077.923922 wlan®.A[542657]
getOP_MODER67:not supported on this interface

20-07-14 16:01:44.703 [kernel]l 2491077.939659 wlan@.A[542658]
getOP_MODER67:not supported on this interface

20-07-14 16:01:44.712 [kernel]l 2491077.948537 wlan@.A[542659]
getOP_MODER67:not supported on this interface

20-07-14 16:01:45.911 [kernel] 2491079.147504 wlan@.A[542660]
updatelLQME3331:No per core RSSI to report

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for with 1
proxy.

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for
bundleID:<private> with 1 proxy.

20-07-14 16:01:46.060 CloudKit TCC accepted a token for
bundleID:<private>, proxy:<private>

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for
bundleID:<private> with 1 proxy.

20-07-14 16:01:46.060 CloudKit TCC accepted a token for
bundleID:<private>, proxy:<private>

20-07-14 16:01:47.279 [kernel]l TX(44:94:FC:20:67:6D) <Success NoACK
Expired OtherErr> BE<O © © 0> BK<O © © 0> VI<O © © 0> VO<0 0 0 0>
(5001ms)

20-07-14 16:01:47.279 [kernel] L3 Control VO TX(44:94:FC:20:67:6D)

The iCloud log extract shows entries from the three major sub-systems involved in iCloud transactions, and
various related services and the kernel in the Other category. These are the same as shown in my free iCloud
utility Cirrus.

=> TCC log
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TCC log

[ NON | Mints TCC & privacy log
Period S sec relative to 14/07/2020, 16:01:40 ¢ Now
TCC @ LaunchServs @ securityd @ Other
Get log Save

20-07-14 16:01:20.338 securityd could not enable test hierarchy: no UAT
pinning preferences set

20-07-14 16:01:20.616 kernel PMRD: setAggressiveness(0)
kPMMinutesToSleep = ©
20-07-14 16:01:20.889 kernel 2491054.125156 wlan@.A[542641]

updateLQM@3331:No per core RSSI to report

20-07-14 16:01:21.760 LaunchServ LSExceptions shared instance
invalidated for timeout.

20-07-14 16:01:21.882 LaunchServ LSExceptions shared instance
invalidated for timeout.

20-07-14 16:01:22.273 kernel TX(44:94:FC:20:67:6D) <Success NoACK
Expired OtherErr> BE<O © © 0> BK<O © 0 0> VI<O © © 0> V0<0 0 0 0>
(5000ms)

20-07-14 16:01:22.273 kernel L3 Control VO TX(44:94:FC:20:67:6D)
Success=0 NoACK=0 Expired=0 OtherErr=e

20-07-14 16:01:22.273 kernel TX(FF:FF:FF:FF:FF:FF) <Success NoACK

Expired OtherErr> BE<O © © 0> (5000ms)
20-07-14 16:01:25.659 LaunchServ LSExceptions shared instance
invalidated for timeout.

20-07-14 16:01:25.897 kernel 2491059.133576 wlan@.A[542642]
updatelLQM@3331:No per core RSSI to report
20-07-14 16:01:26.439 kernel Sandbox: com.apple.Safari(932) deny(1)

file-read-data /Users/hoakley/Library/
Preferences/.GlobalPreferences.plist
20-07-14 16:01:26.442 kernel PMRD: setAggressiveness(9)

The TCC log extract shows entries from the three major sub-systems involved in controlling privacy and controlled
access in Mojave and later. The Other category here includes additional services and the kernel. These are the
same as shown in my free utility Taccy.

=» Time Machine log
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Time Machine log

[ JON ) Mints Time Machine log
Period 2 min relative to 14/07/2020, 16:00:34  © Now
Time Machne @ DAS @ cTs @ Other
Get log Save
20-07-14 15:42:10.153 [other] [<private>] resolving item: (null)

[4212AAFD-3C28-4F5C-85F9-07D6E3FD397D] — URL:/Users/hoakley/Documents/
Xcodel@/T2M2/TheTimeMachineMechanic/TheTimeMachineMechanic.xcodeproj
options: 768
20-07-14 15:44:51.668 DuetAS 0:com.apple.backupd-auto:@45ABB: [

{name: DeviceActivityPolicy, policyWeight: 2.000, response: {Decision:
Can Proceed, Score: 0.40}}

{name: MemoryPressurePolicy, policyWeight: 5.000, response: {Decision:
Can Proceed, Score: 0.50, Rationale: [{[memoryPressure]: Required:2.00,
Observed:1.00}, 1}}

] sumScores:31.810000, denominator:35.510000, FinalDecision: Can Proceed

FinalScore: 0.895804}

20-07-14 15:44:51.668 DuetAS '@:com.apple.backupd-auto:045ABB'
CurrentScore: 0.895804, ThresholdScore: 0.758907 DecisionToRun:1
20-07-14 15:44:51.669 CTS-XPC DAS told us to run com.apple.backupd-
auto

20-07-14 15:44:51.769 CTS-XPC com.apple.backupd-auto state change 1
-> 2

20-07-14 15:44:51.769 CTS-XPC Initiating XPC Activity:
com.apple.backupd-auto

20-07-14 15:44:51.770 CTS-XPC taking power assertion:

com.apple.backupd-auto: 38319

20-07-14 15:44:51.770 TimeMach TMPowerState: 2

20-07-14 15:44:51.770 DuetAS STARTING activity @:com.apple.backupd-
auto:045ABB <private>!

The Time Machine log extract shows entries from the three major sub-systems involved in scheduling,
despatching and making Time Machine backups. The Other category here shows related services, but doesn’t

include the kernel. Although based on the extracts analysed by my free utility The Time Machine Mechanic, these
extracts are new for Mints.

=» App _Store log
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App Store log

[ ] @ Mints App Store log

Period -20 C min relative to 05/05/2021, 12:21:32 z Now
AppStore @ AMS @ appstored @ Other @

Get log Save
21-05-05 12:19:26.513 AppStore App Store bootstrap completed
21-05-05 12:19:26.515 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.519 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no
21-05-05 12:19:26.520 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.523 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no
21-05-05 12:19:26.523 AppStore Onboarding finished.
21-05-05 12:19:26.524 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.525 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no
21-05-05 12:19:26.526 AMS AMSAcknowledgePrivacyTask: [AC15E192] Determining if privacy acknow!
21-05-05 12:19:26.526 AMS AMSAcknowledgePrivacyTask: [AC15E192] Privacy acknowledgement is no

21-05-05 12:19:26.561 appstored [AppStoreKit.UpdateStore]: getUpdatesWithCompletionBlock

21-05-05 12:19:26.561 appstored [C56AD324] getUpdates requested for client: com.apple.AppStore
21-05-05 12:19:26.563 appstored [C56AD324] Returning @ available and 14 recent update(s)

21-05-05 12:19:26.563 appstored [C56AD324] getUpdates completed sucessfully

21-05-05 12:19:26.565 appstored [AppStoreKit.UpdateStore]l: refreshUpdateCountWithCompletionBlock
21-05-05 12:19:26.565 appstored [4DA2F90QE] refreshUpdateCount requested for client: com.apple.AppStc
21-05-05 12:19:26.566 appstored [4DA2F90QE] Current update count: © elapsedTime: 0.000146

21-05-05 12:19:26.566 appstored Leaving badge count at: @ badgeValue: © reason: Client Refresh Couni
21-05-05 12:19:26.566 appstored [4DA2F90QE] Refresh update count returning count: @

21-05-05 12:19:26.566 appstored [4DA2F90E] refreshUpdateCount completed sucessfully

21-05-05 12:19:26.580 appstored [1C178923] Completed with 179 result(s)

21-05-05 12:19:26.600 kernel Sandbox: 1 duplicate report for App Store deny(1) mach-lookup com.a
21-05-05 12:19:26.600 kernel Sandbox: App Store(24415) deny(1) mach-lookup com.apple.remoted
21-05-05 12:19:26.603 kernel PMRD: setAggressiveness(@) kPMMinutesToSleep = @

21-05-05 12:19:26.624 kernel Sandbox: App Store(24415) deny(1) mach-lookup com.apple.AddressBook
21-05-05 12:19:26.630 kernel Sandbox: App Store(24415) deny(1) file-read-data /private/var/folde
21-05-05 12:19:26.631 AMS AMSURLSession: [3BDA5CF9] Task received response

The App Store log extract shows entries from the three major sub-systems involved in obtaining, downloading,
installing and updating App Store apps. AMS is Apple Media Services, and the Other category here shows the
kernel and other related services.

=» DAS Scheduling_log
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DAS Scheduling log

[ JON | Mints DAS-CTS Scheduling log
Period -5/ 7 min ﬂ relative to  11/10/2020, 10:18:05 ot Now
DAS @ cTs @ XPC Remote @ Kernel @
Get log Save

20-10-11 10:14:10.679 XPC-remote [ex7f3911596bf9] Message 2219
recevied , dispatching handler block
20-10-11 10:14:10.679 XPC-remote localbridge> Heartbeat 71564 succeeded

20-10-11 10:14:10.886 kernel 1431315.825506 wlan@.A[296957]
updatelLQME3339:No per core RSSI to report

20-10-11 10:14:11.556 CTS-XPC Creating XPC Activity:
com.apple.mds.Health check (2).0

20-10-11 10:14:11.556 CTS-XPC Submitting DASActivity: <_DASActivity:

"Q:com.apple.mds.Health check (2).0:FBD201", Utility, 6O0s, [10/11/20
10:14:11 AM - 10/18/20, 10:14:11 AM], Group: "com.apple.dasd.default",
Plugin Required, Delayed Start, User Specified: { }>

20-10-11 10:14:11.556 DuetAS SUBMITTING: <private>

20-10-11 10:14:11.556 CTS-XPC Registered XPC Activity:
com.apple.mds.Health check (2).0

20-10-11 10:14:11.556 CTS-XPC com.apple.mds.Health check (2).0:
<dictionary: 0x7fa90f629160> { count = 8, transaction: @, voucher = 0x0,
contents =

"_SequenceNumber" => <uinté4: @x223cbé4c7b68bc51>: 1

"GracePeriod" => <inté64: 0x223ché4ce8c@ac4l>: 604800

"PowerNap" => <bool: @x7fff974464b0>: false

"DuetAttributeName" => <string: @x7fa90fé1clde> { length = 16,
contents = "Health check (2)" }

"Delay" => <inté4: @x223cbé4c7bé8acsl>: ©

"AllowBattery" => <bool: @x7fff974464b0>: false

"DuetAttributeValue" => <string: @x7fa90f6130c@> { length = 1,

The DAS scheduling log extract shows entries from the two major sub-systems involved in macOS background
scheduling, which despatch and execute tasks, DAS (Duet Activity Scheduler) and CTS (XPC, Centralized Task

Scheduling). The XPC Remote category here shows entries for XPC External, and Kernel shows messages from
the kernel.

Routine background tasks in macOS often use this system for their scheduling. DAS determines when they can be
run, according to priorities and load, then calls on CTS to call them using XPC. This log extract lets you watch the
dialog between DAS and CTS, supplemented by information about external XPC activity, and that of the kernel.
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Spotlight log

@ [ ] Mints Spotlight log
Period -40  sec relative to 07/02/2021, 07:08:45 . Now
Server @ Index @ DiskArb @ mdworker/stores @)
Get log Save
21-02-07 ©7:08:17.907 DiskArb set client port, id = mdworker_shared [52564]:221451.
21-02-07 ©7:08:17.907 DiskArb
21-02-07 07:08:17.907 DiskArb mdworker_shared [525671:419867 —> diskarbitrationd [95]
21-02-07 ©7:08:17.907 DiskArb set client port, id = mdworker_shared [52567]:419867.

21-02-07 ©7:08:17.907 mdworker Membership API: translate identifier
21-02-07 ©7:08:17.907 mdworker Membership API: translate identifier
21-02-07 07:08:17.907 mdworker Membership API: translate identifier
21-02-07 ©7:08:17.907 mdworker Membership API: translate identifier
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.931 mdworker Loading Preferences From System CFPrefsD
21-02-07 07:08:17.932 mdworker Loading Preferences From System CFPrefsD
21-02-07 ©7:08:17.952 mds_stores compressing 5686 bytes to <private>
21-02-07 ©7:08:17.954 mds_stores compressing 5740 bytes to <private>

21-02-07 07:08:22.863 Server KEEP!!!!! Client <private>[52556 52556] xpc checking in

21-02-07 07:08:22.882 Server directQueryOpenReply -1827749887 1795162144 @ 0x21

21-02-07 07:08:22.882 Server QueryOpen succeeded (@) for store <private> 0x21

21-02-07 07:08:23.024 Index sort 130923 flat pages: 0.001706 seconds

21-02-07 07:08:23.123 Index sort 381016 flat pages: 0.004475 seconds

21-02-07 07:08:23.207 Server directQueryFetchResultsReply -1827749887 1795162144 35 at qos 0x21
21-02-07 07:08:24.612 Index sort 7039351 flat pages: 0.100238 seconds

21-02-07 07:08:25.355 Server directQueryFetchResultsReply -1827749887 1795162144 35 at qos 0x15
21-02-07 07:08:25.355 Server directQueryFetchResultsReply -1827749887 1795162144 @ at gos 0x15

The Spotlight log extract shows entries from the three sub-systems involved in maintaining and accessing the
Spotlight indexes: Spotlight Server, Index, and Disk Arbitration. The mdworkers/stores category here shows
entries for mdworker_shared and mds_stores.

=» Spotlight check and test
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Spotlight check and test

o © Spotlight Query Test

Spotlight query returned 13 results:
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestB.pdf
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestC.txt
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestE.docx
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestD.html
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestMD. txt
/Users/hoakley/MintsSpotlightTest4syzFiles/SpotTestEXIF.jpg
/Users/hoakley/Library/Group Containers/493CVA9A35.com.red-sweater/Library/Application Support/
MarsEdit4/Backups/The Eclectic Light Company-Spotlight on search_ Better and different, 3rd party
apps.78EAA2B1-3AB1-4E21-A358-723AE8D41E6A. txt
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestD.html
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestB.pdf
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestE.docx
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestC.txt
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestEXIF.jpg
/Users/hoakley/Library/Mobile Documents/com~apple~CloudDocs/backupl/SpotTests/SpotTestMD.txt

Three buttons let you perform tests on Spotlight indexing and search, which are conveniently linked with inspecting its entries in the
log.

Create Test creates a new folder in your Home folder named MintsSpotlightTest4syzFiles to contain the test files. Mints then copies 9
files there for testing purposes. To delete that folder and its contents, use the Delete Test button.

Check Search performs a Spotlight search for the text syzygy999 in files in the whole of your Home folder, including iCloud. It then
opens a new window and displays the results, which should include the test files SpotTestA.rtf (Rich Text), SpotTestB.pdf (PDF),
SpotTestC.txt (plain text), SpotTestD.html (HTML), SpotTestE.docx (Microsoft Word), SpotTestF.numbers (Numbers),
SpotTestG.pages (Pages), SpotTestEXIF.jpg (EXIF metadata in JPEG), and SpotTestMD.txt (Keywords extended attribute). You can
also add your own containing the search text to the folder. In addition to reporting which files were found, Mints also reports UTI and
Spotlight Importer information for each test file in that folder, and gives the time taken to perform the search.

A standard check might start with Create Test at a clock time of, say, 01:00:00, followed by Check Search at 01:00:10. At 01:00:30
open the Spotlight log and set the period to -30 seconds to capture all entries since 01:00:00. When finished, clean up using Delete
Test to delete the test folder and its entire contents, including any custom files you may have put there.

-» Spotlight log
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Get Mac Info

[ JOX ) Mints Mac Info

Mac model = iMacProl,1
Machine name = iMac Pro
Version = 1.0
Serial number = CO2VX2LXHX87
Hardware UUID = 4BB99205-CB23-5758-88EQ-E59A16FF4605
CPU = Intel(R) Xeon(R) W-2140B CPU @ 3.20GHz, 8 cores
Logic board ID = Mac-7BA5B2D9E42DDD94
Physical memory = 32 GB
Total physical memory = 34.36 GB
PCI Devices =
ethernet, Apple AQC107-AFW
Accelerators =
AMDRadeonX5000_AMDVegal@GraphicsAccelerator
AHCI Disks =
Samsung SSD 860 EVO 2TB, rev RVT@3B6Q, serial S4XINE@OMCOO366L
Samsung SSD 860 EVO 2TB, rev RVT@3B6Q, serial S4X1NEOMAG2890F
Samsung SSD 860 EVO 2TB, rev RVTO3B6Q, serial S4X1INE@M702005R
Samsung SSD 860 EVO 2TB, rev RVT@3B6Q, serial S4XINEOMCOO358X
Metal graphics devices =
AMD Radeon Pro Vega 56
Firmware version = 1037.147.4.0.0 (iBridge: 17.16.16610.0.0,0)
Darwin Kernel Version 19.6.0: Thu Oct 29 22:56:45 PDT 2020; root:xnu-6153.141.2.2~1/RELEASE_X86_64
Running macOS Version 10.15.7 (Build 19H15)
Last booted { sec = 1604608205, usec = 267786 } Thu Nov 5 20:30:05 2020

This window lists information about your Mac’s hardware. This includes:

+ the model designator, e.g. iMac17,1, machine name and version

+ the serial number of that specific Mac, its hardware UUID

+ the CPU type and details, and the ID for its logic board

+ physical memory installed (two units), PCI devices (Ethernet card)

+ graphics accelerators, AHCI disks, Metal graphics devices

+ firmware version, kernel version, macOS version, and time of last boot.
Further items will be added to this list in the future.

Increase the size of the text used with 3+; to reduce the size, press 3#— . Save the text to a text file using the Save...
command in the File menu.
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Get Volume Info

 JOX ) Mints Volume Info

Volume <ThunderBayil>:
format APFS (NOT case sensitive)
free space on </Volumes/ThunderBayl> is 593.92 GB of total 2 TB
used space 1.41 TB
available for important usage 653.27 GB
available for opportunistic usage 651.99 GB
sparse file storage available
file cloning available
volume supports compression.

Volume <ThunderBay2HFS>:
format Mac 0S Extended (Journaled) (NOT case sensitive)
free space on </Volumes/ThunderBay2HFS> is 1.77 TB of total 2 TB
used space 232.93 GB
available for important usage 1.77 TB
available for opportunistic usage 1.77 TB
sparse file storage NOT available
file cloning NOT available
volume supports compression.

This window lists capacity information for all volumes currently mounted in the path /Volumes. This includes:

+ volume name, format and case sensitivity

+ total free space and total capacity

+ the derived used space

+ the amount of space available for ‘important’ and ‘opportunistic’ use

+ whether sparse files, file cloning, and compression are supported.
On APFS volumes, this should include mounted snapshots, but doesn’t include the current Data volume in the startup
Volume Group (as that isn’t mounted in /Volumes).

Increase the size of the text used with 38 +; to reduce the size, press 3&— . Save the text to a text file using the Save...
command in the File menu.
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Get Keychain Info

[ JOX | Mints Keychain Info
Check

Default (login) /Users/hoakley/Library/Keychains/login.keychain-db
keychain

unlocked readable writeable

Lock

Mac UUID: 4BB99205-CB23-5758-88E0-E59A16FF4605

Keychain Services version: 33718272

‘% Found default keychain.

The default keychain is now unlocked, readable, writeable.

Default keychain path: /Users/hoakley/Library/Keychains/login.keychain-db
& Current keychain search path:
/Users/hoakley/Library/Keychains/login.keychain-db
/Users/hoakley/Library/Application Support/Adobe/AIR/ELS/
com.adobe.formscentral.FormsCentralForAcrobat/PrivateEncryptedDatak
/Users/hoakley/Library/Keychains/loginMPro.keychain-db
/private/var/folders/t9/dsdtkd0161b3w6fcjhlyqvjm0000gn/T/accountsKeychainExportBC5/
accountsKeychainExport.keychain

/Library/Keychains/System.keychain
/Users/hoakley/Library/Keychains/login.keychain-db
/Users/hoakley/Library/Application Support/Adobe/AIR/ELS/
com.adobe.formscentral.FormsCentralForAcrobat/PrivateEncryptedDatak

This window has three simple button controls:
« Check, which runs its checks and updates the information in its text boxes;
+ Unlock, which unlocks your default (login) keychain;
+ Lock, which locks your default (login) keychain.

When you click on the Check button, Mints runs its full battery of tests, and completes the text boxes as shown below.

Displayed in the Default (login) keychain box is the full path to the keychain which macOS is using as your main user
keychain at present. Even if you are using iCloud Keychain, this should be a path to the file named login.keychain-db in the
Library/Keychains folder of your Home folder. If it isn’t, then you need to establish why.

=» Get Keychain Info (concluded)
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Get Keychain Info (concluded)

Below that box are three smaller boxes, which tell you whether that default keychain is locked, readable, and writeable.
You can change two of those by clicking on the Unlock or Lock buttons nearby. When you click on Unlock, a dialog will
appear requiring you to enter the password for your default keychain (which should be the same as your normal user login
password) in order to unlock that keychain, although in Catalina that may only appear when you click on Lock.

Mints wants to use the “login” keychain.

Please enter the keychain password.

Q
L OO0 password: ||

? Cancel O

The bottom scrolling box contains the hardware UUID number of your Mac, its version number of Keychain Services, all the
information from the other boxes, and a lot more too.

You can save that to a text file using the Save... command in the File menu. You can also select, copy and paste any of
the text, but cannot modify it within this app.

You can resize text in the lower scrolling window between 4 and 24 points using ¥+ to enlarge and - to reduce the size.

=» Keychain Details
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Keychain Details

Mac UUID: this should correspond with the Hardware UUID given in System Information.
Keychain Services version: this should be 33718272 for all versions of macOS from 10.12 to 10.15.

Default keychain path: should be /Users/[username]/Library/Keychains/login.keychain-db where [username] is the short user name
of the current user.

Current keychain search path: should include the default keychain and /Library/Keychains/System.keychain.

Keychain system search path: should include /Library/Keychains/System.keychain.

Keychain common search path: should include /Library/Keychains/System.keychain.

Keychain dynamic search path: most probably empty.

Keychain user search path: should include the default keychain.

Contents of ~/Library/Keychains: should include login.keychain-db, and is likely to include metadata.keychain-db too. For each file
found, the date and time of last modification is given first, then that of the file’s creation, then the size in bytes. The default keychain
should not be empty.

Contents of ~/Library/Keychains/[UUID]: this is the folder used for iCloud Keychain, or for the Local ltems listed in Keychain
Access. It may not exist, but if it does it should include keychain-2.db at least, and sometimes much more.

Contents of /Library/Keychains: should include System.keychain, and may well also include the Apple Push Services keychain
apsd.keychain

Contents of /System/Library/Keychains: should include SystemRootCertificates.keychain and is likely to contain EVRoots.plist,
X509Anchors, and SystemTrustSettings.plist.
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Get Environment Info

() @ Mints Mac Environment

The environment is

["SSH_AUTH_SOCK": "/private/tmp/
com.apple.launchd.fJKbanU5np/Listeners", "SHELL": "/bin/
zsh", "COMMAND_MODE": "unix2003", "USER": "hoakley",
"__CF_USER_TEXT_ENCODING": "@x1F5:0x0:0x2", "PATH": "/
usr/bin:/bin:/usr/sbin:/sbin", "HOME": "/Users/hoakley"
"__CFBundleIdentifier": "co.eclecticlight.Mints",
"TMPDIR": "/var/folders/sz/
qb23fyss56v96vmh60p8ft7r0000gn/T/", "XPC_FLAGS": "@xo",
"LOGNAME": "hoakley", "XPC_SERVICE_NAME":
"application.co.eclecticlight.Mints.3126273.3126278"]
en_GB (current)

Controller:

Controller Information:
Model Name: Apple T2 Security Chip

Firmware Version: 18P4346
Boot UUID: 32379261-FA9A-4048-8CE3-088D26DE9A58

This window shows the process execution environment which processes launched by Mints would inherit. This is
of particular interest to anyone experiencing problems which may be attributable to environment variables.
Although the environment shown is that for Mints, it should be typical of most apps run. Of particular interest are
the shell, text encoding and any localisation, and TMPDIR variables.

Following that, an assessment is made as to whether the current version of macOS has been patched to fix the
serious vulnerability in the sudo command.

The Controller information given at the end is specific to the type of Mac, differing between non-T2 and T2 Intel
systems, and M1 Macs.
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Mach Absolute Time

@ ® Mints Mach Timebase Info

Running as Intel code:
Timebase numerator = 1
denominator = 1

factor = 1.0

Mach Absolute Time (raw) = 2812811885701462
Mach Absolute Time (corr) = 2812811885701462

This window displays conversion factors and other information about Mach Absolute Time, which differ between
Intel and Apple Silicon hardware, and between Intel code running using Rosetta 2 and native ARM code on Apple
Silicon systems.

This first line states which architecture the code was run on, then gives the two integers for the Mach timebase
correction, and the correction factor; multiply raw time values by that to scale them from ticks to nanoseconds.
Finally, it gives the current raw time, and that time after correction.

To discover the factors applied to Intel apps running in Rosetta 2 translation on an Apple Silicon Mac, force Mints
to Open using Rosetta on that Mac.

The Eclectic Light Company blog — https://eclecticlight.co



https://eclecticlight.co

=» Start =» Contents

Universal binary checker (Mojave and later)

o @ /Users/hoakley/Documents/Oarchtests

Folder Flush
Scan Check all bundles Check Mach-O Save

Listing of all bundles which have ARM64 code in the folder /Users/hoakley/
Documents/Oarchtests:

[Users/k Oarcl /ArchiChect.app

JUsers/t Oarc /ArchiChect.app/C AacOS/ArchiChect

/Users/hoakley/Documents/Oarchtests/Cil al

[Users/t chtests/Cirrus..
y

0S/Cirrus

0S/Podofyllin

Found 10 items which have ARM64 code, out of 7082 scanned in /Users/hoakley/
Documents/Oarchtests (including Mach-O files)
Checked at Monday, 20 July 2020 at 16:59:20 British Summer Time

Before scanning for Universal software, decide whether you just want apps scanned, or whether you want all code-containing
bundles scanned. To scan apps only, leave the checkbox labelled Check all bundles unchecked; to scan all bundles, ensure it is
ticked (the default).

Next, decide whether you want all executable (Mach-O) code files scanned too. These include dynamic libraries (dylibs), command
tools, and other code which is not delivered in a bundle. To scan all executable code, ensure that the checkbox labelled Check
Mach-O is ticked (the default); for a basic scan, leave that checkbox unchecked. Scanning all bundles and all Mach-O files will take
significantly longer.

Then decide which folder you wish to scan. You can select that in either of two ways:

+ leave the Folder text box empty, and click on the Scan button. You will then be prompted to select the folder using the normal
Open File dialog;

+ enter a standard path into the Folder text box. You can use the standard shortcut of ~ to indicate your Home folder. Once you
have entered the path, click on the Scan button to start the scan. If the Flush checkbox is ticked when you do this, the path in
the Folder text box will be cleared when the scan starts; if you uncheck the Flush checkbox, your path will be left for you to
edit it for the next scan.

=>» Universal binary checker (concluded)
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Scanning takes time. If you put the root path / in the Folder text box, this can take many minutes, even an hour or
so. You may wish to scan top-level folders like /Applications one at a time rather than attempting to scan your
entire Mac. During this period, the window shows a busy ‘spinner’ next to the Scan button, and you can work
normally with other apps. Give the app time to complete its scan, and once complete it will display the results.

Scanning takes plenty of memory. Because of the deep traversal which it uses, Mints consumes memory by the
GB in order to check every nook and cranny in the folder it is scanning. This should work fine with virtual memory,
though. Again, you can reduce this by performing scans on smaller folders.

When a scan is complete, the title of the window will change to show the folder which has just been scanned.
Change the size of the text in the output using 3+ to make it larger, to a maximum of 60 points, or 3— to make it
smaller, to a minimum of 4 points.

To save the results of a scan as a text file, click on the Save button, or use the Save... command in the File menu.
You will then be prompted to select the name of the text file.

The scanner performs a deep traversal of the chosen folder, using Bundle.executableArchitectures to list
executable architectures for each bundle. To check for Mach-O code files, it first inspects the ‘magic’ initial four
bytes of every file. If it finds that they are 0xfeedface, it then directly inspects the subsequent Fat Architecture
slices to check whether the supported architectures include ARM64.
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Data... menu: Double

O O Mints Double Arithmetic Tests

Double arithmetic tests:

Muller-Kahan test results:
3 18.5

4 9.378378378378379
5 7.801152737752169
6 7.154414480975333
7 6.806784736924811
8 6.592632768721792
9 6.449465934053933
10 6.348452060746624
11 6.274438662728116
12 6.218696768582163
13 6.17585385581539
14 6.142627170481006
15 6.120248704570159
16 6.166086559598099
17 7 223RA211ARR24021

This new group of menu commands in the Window menu opens a new window which lets you explore different
types of data. The first to be provided here looks at floating point arithmetic using the standard Swift type Double.
These include the results of ‘difficult’ tests which normally generate inaccurate results, including the Muller-Kahan
test, the Chaotic Bank, and the Rump test. For each, the standard result generated by modern Intel processors is
given. The final group of tests demonstrates how calculating in different orders can induce numeric errors.
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Updates

Whenever you open Mints, it may check to see if an update is available. This doesn’t use the popular Sparkle mechanism
for updating in place, but works as detailed here.

Once Mints has successfully completed its integrity check, it checks whether update checking has been turned off in its
preferences file. If that has, it abandons any attempt to check for updates. If checking is allowed, it then checks when it last
checked for updates. If that was more than 12 hours ago, it continues to perform the check. It then connects to my GitHub
server, from where it downloads a list of current versions of my apps. It doesn’t upload any data to the GitHub server at all,
and no statistics beyond GitHub normal connection figures are collected either: no personal identifiers are recorded.

If there is an update available, Mints then checks that its location is on this WordPress blog, and posts a dialog which
invites you to download the update.

If you click on the Download button, it then points your default browser at that update, which should trigger the update to
be downloaded to your normal downloads folder. The update is received as a regular Zip archive, and is exactly the same
as you would download from the Downloads page here. It also carries a quarantine flag, so that when you unZip it and
install the app inside, it undergoes normal first run ‘Gatekeeper’ security checks. If you click on the Ignore button, Mints
won’t remind you about it again for another 12 hours.

An additional item at the end of the Help menu explains the update status. If no update check is performed, or the check
fails, the last item reads Update not checked. If the check is performed and update information is obtained, even when no
update is available or you decline to download it, that menu item reads Checked for update and is ticked (but still
disabled).

You can customise this behaviour by changing Mint’s preferences. The keys to use are:
noUpdateCheck, a Boolean. When set to true, this disables all update checking. Default is false.
updateCheckInt, a real number (Double). When set to a value greater than 1.0, the minimum time interval between checks, in
seconds. Default is 43200, which is 12 hours. If you set it to any value less than 1, Ulbow will reset it automatically to that
default.

To change either of these, use a Terminal command of the form
defaults write co.eclecticlight.Mints updateCheckInt '10'

which works properly through the preferences server cfprefsd.
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Further Information

The monospace font using in versions of macOS up to and including Mojave is monospacedDigitSystemFont;
that used in Catalina and Big Sur is monospacedSystemFont, which is unfortunately not available in earlier
versions of macOS. Both are used in their regular weight.

Predicates used to obtain log extracts include:
* subsystem == "com.apple.clouddocs" OR subsystem == "com.apple.cloudkit" OR subsystem ==
"com.apple.mmcs" OR processImagePath CONTAINS[c] "cloudd" OR processImagePath CONTAINS[c]

"bird" OR processID = 0 (for iCloud)

* subsystem == "com.apple.TCC" OR subsystem == "com.apple.launchservices" OR subsystem ==
"com.apple.securityd" OR subsystem == "com.apple.sandbox" OR processImagePath CONTAINS[c]
"tccd" OR processImagePath CONTAINS[c] "sandboxd" OR processID = 0 (for TCC)

* subsystem == "com.apple.TimeMachine" OR (subsystem == "com.apple.duetactivityscheduler" AND
eventMessage CONTAINS[c] "Rescoring all") OR (subsystem == "com.apple.xpc.activity" AND

eventMessage CONTAINS[c] "com.apple.backupd-auto") OR eventMessage CONTAINS[c] "backup" OR
eventMessage CONTAINS[c] "Time Machine" OR eventMessage CONTAINS[c] "TimeMachine" (for Time

Machine)

* subsystem == "com.apple.duetactivityscheduler" OR subsystem CONTAINS "com.apple.xpc" OR
processID = 0 (for DAS scheduling)

* subsystem == "com.apple.spotlightserver" OR subsystem CONTAINS "com.apple.spotlightindex" OR

subsystem CONTAINS "com.apple.DiskArbitration.diskarbitrationd" OR processImagePath
CONTAINS[c] "mdworker shared" OR processImagePath CONTAINS[c] "mds_stores" (for Spotlight)

* subsystem == "com.apple.AppStore" OR subsystem == "com.apple.AppleMediaServices" OR subsystem
== "com.apple.appstored" OR subsystem == "com.apple.JetEngine" OR processID = 0 (for the App
Store).

Extensive information about Mints and the unified log is available from the Eclectic Light Company blog, and the
product page in particular. That can be accessed through the Mints Support command in the Help menu too.
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Change list

1.4:
+ added App Store log access
+ added Window/Data... menu with a single window for Doubles.

+ improved opening log checks to detect time formatting errors.
+ refactored the display of log entries to reduce memory requirements and increase performance.
+ brought all time formatting into line with latest changes in macOS 11.

+ added opening log checks to protect against macOS bugs.

+ added busy spinner and search timing to Spotlight test
+ added sudo test to the Environment feature.

+ additional files for Spotlight test

+ added mdimporter info for Spotlight test

+ first full release.
1.0b11:

+ added Environment info window

+ added Spotlight section, complete with test files

+ laid out main window more systematically.
1.0b10:

+ added many new items to the Mac Info feature, with support for Apple Silicon Macs too.
1.0b9:

+ added DAS Scheduling log browser

+ revised Volume Info and corrected its coverage and information

+ fixed a bug in Mac Info which resulted in crashing if that Mac’s logic board had no serial number.
1.0b8:

+ added Mac Info feature

The Eclectic Light Company blog — https://eclecticlight.co



https://eclecticlight.co

=» Start =» Contents

1.0b7:
+ added Volume Info feature
+ added Keychain Info feature
+ added support for saving via menu command to main windows.
1.0b6:
+ added Mach Absolute Time feature
+ minor tweaks to the interface.
1.0b5:
« changed algorithm used by Universal Binary Checker to stop using lipo
+ Universal App for for Intel and Apple Silicon Macs.
1.0b4:
+ changed standard log text colours to black/white, red, blue, green
+ added Universal Binary Checker for 10.14 and above.
1.0b3:
+ tried to fix further bug opening log windows in Sierra.
1.0b2:
+ fixed weird bugs in the log window nib.
1.0b1:
+ first beta release, with iCloud, TCC and Time Machine log browsers.

5 May 2021.
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